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Whats On …... General Meeting – Thursday 7 July 2011 at Buderim
Technology
Education
Centres
Caloundra
Buderim
Yandina

• Get hands on help with all your technology problems.
• Tutorials are presented during each session.
• Internet and Intranet access is available.
Windows, Linux and Apple Mac operating systems are supported.
Every Saturday between 9.00 am and 12.30 pm
Caloundra Youth hall, Queen Street Caloundra, (opposite High School).
Every Thursday between 1pm to 4pm (starting 7th July 2011)
Good Life Centre, 100 Buderim Pines Drive, Buderim.
3rd Wednesday of the month between 1.30 pm and 4.00 pm.,
RSL Hall, North Street, Yandina

Notice about SCCC Monthly General Meetings
The SCCC Monthly Meetings alternate between the Caloundra and Buderim venues. In Caloundra the meeting is held on the first
Saturday of the month and in Buderim the meeting is held on the first Thursday of the alternate month.

The next SCCC Monthly Meeting will be at Buderim on Thursday 7 July.
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From The Editor – Judy Smith
Bits'N'Bytes is produced monthly from February to
December each year.
Contributions for the newsletter are always welcome.
Please send copy for the next issue to reach the editor
as early as possible after the monthly meeting or by the
deadline: 25 July 2011.
Email: editor@sccc.org.au or Snail Mail: The Editor PO
Box 384, Caloundra, Qld 4551.

Membership Cards for Collection - Membership
cards for those members who joined or renewed
membership for the month ending 20 June 2011 are
available for collection at Caloundra and Buderim
meetings. Cards that have not been collected in the
previous twelve months are also available.
Note - Membership cards show the next renewal date
of membership.

This magazine is created with OpenOffice and
produced in printed form and also electronically
in PDF format.
Copyright - material in this newsletter may be copied
in other publications provided that copyright rests with
the Sunshine Coast Computer Club Inc., This permission
is on condition that reference is made to SCCC (with
original published date) in the reprinted item.
Liability - Although articles in this newsletter are
checked for content, no warranty can be given for any
loss resulting from the use of material in the newsletter.
Articles and advertisements are printed in good faith
and views and opinions are not necessarily those held
by the club.
SCCC Privacy Statement - In joining the Sunshine
Coast Computer Club please note that it is a club
operated by volunteer members and operating within
the community involving many activities relating to
meetings, instructional and social functions for
members and at times visitors.
This requires the keeping of a member data base and
the publication of the names of new members. The
Club guards the member data base as best as possible
and does not publish member's addresses nor
telephone numbers unless authorised.
At times photographs are taken at meetings and
functions and are sometimes published. Should you
have any problems relating to your personal privacy
which arises or is likely to arise, it is your duty and
responsibility to advise the Club secretary in writing of
the circumstances and requirements.
What's on Bulletin - What's On Bulletins are sent once
a week, generally on a Monday afternoon, to all members
who have provided the Club with their email address.
These bulletins give details of up-coming tutorials and
topics to be covered at the various meeting venues. You
will also find items of interest and club announcements in
these bulletins.
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CHANGES ARE HAPPENING AT
BUDERIM
The regular Wednesday morning meetings at the
Goodlife Centre, 100 Buderim Pines Drive Buderim
will change to Thursday afternoons in July 2011.
The last Wednesday meeting will start at 9.30am on
29 June 2011.
The first Thursday meeting will be 7 July 2011.
The Thursday meeting times will be 1pm to
4pm
These changes have been implemented to provide
members with better facilities and added comfort.
We will occupy the the entire top floor of the
building so the various groups will be able to set up
and enjoy more space and not be bothered by noise
from other groups.
The change will also alleviate the current Wednesday
morning parking problems.
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Reports
Treasurer's Report
Profit and Loss
Cash Basis 20 MAY 2011 – 2l JUNE 2011
Income
Fundraising
Meetings
Membership fees
Sales
Total Income
Expense
Administration
Fundraising Expense
Hall Hire
Internet Service Provider
Office Supplies
Postage
Printing/Stationery
Refreshments
Sundry Equipment
Furniture
Total Sundry Equipment
Travel Reimbursement
Total Expense
Net Income

609.00
2788.00
1691.46
20.00
5108.46

600.00
546.90
1328.50
39.95
116.90
82.85
278.87
563.19
96.00
96.00
17.76
3670.92
1437.54

Minutes of the Sunshine Coast Computer Club
General Meeting
Held at the Caloundra Community Youth Hall
Queen Street Caloundra
4th June 2011
Meeting: Commenced 11.00 am
Apologies: Tom Bray, Peter Dodwell, Andrew Hadland.
Minutes of Previous Meeting: No Business arising
from the previous months minutes.
Motion proposed by Ian Smyth that the previous
months minutes be accepted was Seconded by Roy
Potter.
CARRIED
New Members: Peter and Dinny Garnsworthy, Ian
Hay, John Langford, Pauline Macqueen,
Mary Parker, Chris W Phillips,Doreen Sonsee, Morgan
and Vivienne Williams.
Treasurers Report: Treasurer Leo Kavanagh
presented his report for the period 21/04/11 to
20/05/11. Leo announced that we have some big bills
to pay this month, 1837 we have to renew our
insurance, which last year was $2,100, so we expect
that to have increased this year. We have successfully
de registered the club from paying GST in the future
but the tax department have gone back through our
assets and we owe them $1,400, once this is paid we
will be free of GST.
The Treasurers Report is published each month in this
magazine, any members wanting a more detailed report
may request this from our treasurer Leo Kavanagh.
Leo Kavanagh proposed that the Treasurer's Report be
Accepted, this was Seconded by Judy Skinner.
CARRIED
General Business: Peter Daley asked if any members
had any business they wished to discuss. He then
announced that the Buderim Meeting day and time
would change from Wednesday mornings to Thursday
afternoons, starting on 7th July at 1pm. We will be able
to occupy the whole top floor of the building, so the
various groups will enjoy more space and not be
bothered by noise from other groups. It will also
alleviate the parking problem.
Meeting closed at 11 15am
Marie McGregor (Secretary)
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Buderim Venue Changes - President Peter Daley
clearly demonstrated by the increasing number of
members attending the Buderim venue.

On Thursday the 7th of July the SCCC venue set up and
timetable for the club's Buderim Technology Education
Centre will change from Wednesday to 1pm to 4pm on
Thursday afternoons. This is to cater for the growing
Buderim attendance numbers. It also means that the
layout and location of the club activities at the Good
Life Centre will be changed. There will be a lot more
parking spaces available because we have tried to time
the club activities for when the Good Life Centre is less
booked by other groups. This has been a problem over
recent months

Remember, as a member of the Sunshine Coast
Computer Club Inc. you can at any time attend
any of the club Technology Education Centres
located at Buderim, Caloundra, and Yandina.
The committee is always open to suggestions from
members to improve club services, so please feel free
to make suggestions.

The club has now been able to book the entire top floor
of the Good Life Centre on Thursdays. This means the
main tutorials can now be conducted in a separate
room from other activities. This will alleviate the noise
problems associated with all the activities happening in
the same room when the main tutorial P.A. system is in
use. The main tutorials will be conducted in the large
room next to the toilets on the top floor.
The smaller interest groups will have dedicated areas
around the main hall. The Linux, OpenOffice, Apple,
and Family History groups will have their own dedicated
area. Also, each interest group will have a data
projector and computer so they can project their
tutorials onto the main hall walls. This will allow these
groups to have more space to spread out and provided
a better environment for viewing what is being taught,
and presented to each group.

Protect Your Identity – Advice from
SCAMwatch
www.scamwatch.gov.au

There will be many more table places available for
members to place the personal computers they bring
along. Because more room is available, more tables can
be provided as required. Club computers for members
use will still be available, and be placed along one of
the walls near the top car park entrance.

•

Only give out your personal details and
information where it is absolutely necessary and
where you have initiated the contact and trust
the other party.

•

Destroy personal information, don’t just throw it
out. You should cut up, burn or shred old bills,
statements or cards so scammers can not get
your personal details from them later.

•

Treat your personal details as you would treat
money: don’t leave them lying around for
others to take.

•

Order a free copy of your credit report every
year to make sure no one is using your name to
borrow money or run up debts.

There will be some fine tuning in the first few weeks to
get the best use of the new space. So be patient, we
are trying to get it right, and it will get better with time.
The afternoon tea break will still be in the main hall.
I would like to thank all the volunteers and committee
members who every week set up and run the club
Buderim Technology Education Centre. It is a credit to
them that it runs so smoothly, and efficiently. This is
Page 4
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Optical Character Recognition on Linux - John Glynn
Optical character recognition (OCR) is a program that
converts text in an image (e.g. photo or scanned
image) into a text file, which can then be manipulated
or loaded into Open Office where the font, layout etc.
can be changed.

4. Use Colours-> Treshold to enhance the contrast
between the background and foreground
colours. Make sure the preview box is ticked.
Move the triangular black slider back & forth to
get the best clarity for the text. Choose a
setting where the feet of the characters do not
merge. I've found that this step is not
necessary for most images. If you don't like the
final result you can always try with a different
setting.

Linux has lacked a good OCR program like Omnipage
for Windows, however lurking in the background for
some years has been a backend for OCR called
tesseract. Tesseract was developed by Hewlett Packard.
This backend does an excellent job of actually
converting the image into text but it has no graphical
frontend interface and has no help or man page. Also it
will only work with TIFF files. Install tesseract with the
Mandriva Control Centre (Install & Remove Software) or
with #urpmi tesseract in a root konsole.
Luckily the GIMP makes preparation of the image file
fairly straightforward. Tesseract can only handle
uncompressed single bit tiff files, so you need to
convert your existing image into this format. Tesseract
also cannot handle multicolumn pages. The steps
necessary to prepare a tiff file for tesseract are as
follows:1. Use the rectangular selection tool to separate
the text into separate columns.

5. Use Layer → Transparency and select Remove
Alpha Channel.
6. Go back to Image→Mode & select Indexed. This
brings up another box – choose Black and
white – check that dithering is off. Click on
Convert.
2. If the image is small enlarge it with Image →
Scale Image I use an image width ~ 2/3000

7. Save the file using File->Save As and select the
tif,tiff file option or simply add .tif at the end of
the file name. Select Uncompressed when
asked.
To do the conversion open a konsole window and
change to the directory where the tiff image file is
located and type
tesseract <image filename> <outputfile name

3. Check Image → Mode is RGB or Greyscale

Do not use an extension on the output filename
tesseract will add .txt to the filename

-

Finally I have noticed that I get much better results if
there is a good margin between the text and the
image edge. Good Luck!
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Training Session 5 - Macintosh Home Folder and Backing Up – Ian Stringer
Home Folder: With a blank screen, open a New
Finder Window (⌘N) from the Finder File drop down
menu. In the gray Sidebar, under PLACES, click on the
house icon. This is your Home Folder, and usually
has your name against it. This opens a list of folders in
the first white column.
The Desktop folder shows what is currently open on
your desktop, and is the same as the PLACES Desktop.
The Documents folder is the same as the PLACES
Documents, and should contain most of your work.
Note that this folder has a further Documents folder
inside it. This second folder contains folders/files you
may have put in the Documents Stack in the Dock.
The Documents Stack is a great place to keep
folders/files you use frequently.
The Downloads folder shows folders/files you have
downloaded off the Internet; they are also in the
Downloads Stack in the Dock. If you save
attachments from e.g. emails, they will be saved here.
So you can find them in both places.

Library is your personal library; other users will have
their own separate library. Have a look, but do not
touch anything in this Library!!
Movies is where you can access your movies and store
them. You can store DVDs here, too. You create movies
by opening the iMovie application.
Music is where your iTunes keeps your CDs, etc. Do
not tinker with these folders/files; open the iTunes
application to access your music and other features of
iTunes. Music you create with GarageBand is also
stored there.
Pictures is where iPhoto keeps your pictures. You
open the iPhoto application to access your pictures
and other features of iPhoto. I have several extra
folders in here for other graphic items (e.g. clipart),
including a folder I call Pics, where I keep large albums
that I do not want to keep in iPhoto.

crashes...’ is so true, and I cannot stress too strongly
that you need to back up your Home Folder
frequently - at least monthly; weekly if you use your
computer a lot (some people do it daily). You can now
buy large external hard drives for less than $100, and
the USB drives are small and convenient. The
Macintosh has an Application called Time Machine,
which automates backing up your work, and recovery
when needed; it is very easy to use.
Plug your external hard drive directly into a USB port on
your computer (not a USB hub or the keyboard). Click
on Applications in the gray Sidebar, then click on
Time Machine. A window will open that will lead you
through setting up your Time Machine. It will
automatically open Time Machine Preferences. Tick
the box to Show Time Machine status in the menu
bar; this will put an icon like a clock in the right hand
end of the top menu bar. Click on this icon to open the
drop down menu. Select Back Up Now. I find it useful
to open Time Machine Preferences... as well so I
can watch the progress. Have a look at the resulting
pane.
It might be best for me to demonstrate how to Backup
and Restore on the Time Machine at the Club. It is
much easier to use than to describe!
Training Session 5 - Macintosh Home Folder and
Backing Up
© Ian Stringer 15 June 2011
T S 1 - Macintosh ‘Finder‘ - March 2011
T S 2 - Macintosh Finder Features - April 2011
T S 3 - Macintosh Finder Menu Items - May 2011
T S 4 - Macintosh Applications & Dock - June 2011

Public is a Shared Folder where you can place
folders/files for other people to access. This folder has
a Drop Box, where other people can put files onto
your computer. This is something of a mystery for me,
as I don’t interact with other computers.
Sites has to do with Websites and the Internet (I
think).
Backing Up: Note that your Home Folder contains
all your computer information, not just your
documents, so this is what you need to back up
regularly. The saying ‘Not if, but when your Hard Drive
Page 6
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Jeans Jottings
Windows 8 Preview
From PC Rescue “Digital Times” 9 June 2011

attacks occur and what you can do to detect and
prevent such attacks.

“A few weeks ago Microsoft CEO Steve Balmer let the
cat out of the bag by mentioning the next version of
Windows. Last week they confirmed work on Windows
8 is well underway by releasing a preview of what the
system will look like.

Sophos
has
released
a
useful
video
(http://www.youtube.com/watch?
v=xIZwE1rlNR0&feature=player_embedded) explaining
how this can occur in reality. The video also
demonstrates the second stage of the attack, involving
the installation of the fake anti-virus software and gives
you a good idea about what they look like and how
they work.

Windows 8 is going to come at a critical time for
Microsoft as they are being left behind in the move to
the cloud based, mobile Internet which Apple and
Google are embracing. Their new operating system is
going to have to deal with a lot of concepts that
Microsoft have to date struggled with. We'll be watching
what Microsoft do very closely.
If you're looking at buying a computer, don't let the
upcoming Windows 8 release alter your plans. Given it's
not expected to be available until the middle of next
year and we recommend you wait at least a few
months before buying the new system, it's not worth
considering the new version of Windows until the end
of next year.
Eighteen months is a long time in the computer world
and just how the marketplace will look then is anyone's
guess. Right now it's difficult to see how Microsoft are
going to reclaim leadership from Google and Apple in
this field.”

WAYS
CRIMINALS
MANIPULATE
SEARCH
ENGINE RESULTS TO FOOL PEOPLE INTO
CLICKING ON LINKS TO MALICIOUS WEB SITES.
From Stay Smart Online Newsletter June 2011
(http://www.ssoalertservice.net.au/content/doc/June20
11.pdf)
The above link gives details of how criminals
manipulate Search Engine Results to lure unsuspecting
people into clicking onto links to malicious web sites in
order to compromise their computers for fraudulent
purposes. The article explains more about how these

What can you do to protect yourself online? In cases
such as this it is important to rely on a variety of
counter-measures, such as those outlined in http://www.ssoalertservice.net.au/view/3a53c9a71576a
260ccf8018ba7e4df70
When it comes to installing software – as a general rule
– do not install it if you did not actively go looking for it.
Ask yourself – could this be a trick? If you didn't
actively go looking for it, chances are you don't really
need it and you could save yourself a lot of pain trying
to remove it if you later discover it was harmful.
The information in the article has been given to
members numerous times in various tutorial given at
the Club. Members especially those who are unable to
attend meetings would be well advised to at least look
at the video to see screen shots that will make them
more aware of what to look for.
ABC Programme Nightlife- Paul Wallbank
In the Nightlife programme on Thu 30 June 11 from
after the 10.00 pm news bulletin on ABC radio Tony
Delroy will have Paul Wallbank with him to tell us what
to make of the wave of cyber crime we have been
seeing in the news lately. Towards the conclusion of the
programme there are generally answers to questions
from callers. A podcast of the programme will be
available a day or so later. Go to the Nightlife site at http://www.abc.net.au/nightlife/ - and click on the
Podcast tab and go to the Recent Episodes and look for
one headed Thu Nightlife. At the bottom of the text
about the programme are the words 'Downloaded as an
MP3'. You may either right click on 'MP3' and from the
drop down click on 'Save file as and the file can be
downloaded and kept on file, or left click on the bar
below these words and the programme will start to play
from the site.
Note that the Podcast list is continually being updated
so these instructions may not read as above for any
length of time.
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Technician's Diary – Peter Dodwell
One of my clients came to me with a problem a few
days ago. He wanted to copy a file
to his second hard disk. The
process failed with a cyclic
redundancy check (CRC) error
message. When you save a file, it
is recorded in one or more sectors
on your hard drive or other
recording media. The system then
calculates a mathematical hash for future checks of the
file's integrity which is stored on each sector. "CRC"
errors happen when there's a surface defect with either
the source or the destination media which prevents the
file from being 'read' correctly.
The fact that he saw it when trying to copy a file
indicates that the bad spot may be either within the file
itself or on the destination drive.
The first step is to check where the error might be.
Here's how. Copy the file again, and try to paste it to a
USB memory stick. If this fails with the same message,
then the error is in the source file. On the other hand, if
it copies correctly, the error is on the original
destination drive. Supposing that the error is within the
original file, we need to repair it as much of it as
possible by copying it somewhere else. This has to be
done from the command line. Note that you'll have to
know the name of the file and its location. In XP, open
the 'Start' menu, select 'Run', type cmd in the run box
and press enter. In Vista & 7, click the start button, type
cmd in the search box, right click on the cmd item, and
select run as administrator.
This will open the
command prompt. C:\Windows\system32> in Vista &
7, or C:\Documents and settings\(username)>. In all
cases type in cd .. and press enter, then do it again to
get to the c prompt (C:\>). Once here, navigate
(CD=change directory) to wherever the file is located

'Properties', open the 'Tools' tab, then select check drive
for errors. You'll have to restart the computer so that
the program can run before anything else starts. If all
goes well, this should lock out any faulty sectors. But
beware, your drive may be on the verge of failing. But
at least, you'll have time to safeguard any valuable
data.

Stay Smart Online Alert Service

Stay Smart Online is the Government's cyber security
website designed to help Australians understand cyber
security risks and educate home and small business
users on the simple steps they can take to protect their
personal and financial information online. The website
is hosted by the Department of Broadband,
Communications and the Digital Economy and has
received input and support from a range of other
Australian Government agencies which have related
responsibilities.
Stay Smart Online Basic Information
The internet has increasingly become part of our daily
life. It provides a way for us to connect and
communicate with the outside world. It's important to
secure your computer properly—otherwise you may be
putting yourself at risk. There are six simple things you
can do to better protect yourself online:
•
•
•

C:\>CD (to wherever the file is located.
C:\wherever>xcopy /c myfile.doc F:
(or whatever drive letter for memory stick).
1 file(s) copied.

•
•

Two important things to note here: I've used the xcopy
(for eXtended copy) command, and I've added the
"/C" switch which keeps copying even if errors are
encountered. The default behaviour XCOPY is to stop if
an error occurs.
Now that we've got a "no worse than" backup copy, we
can start attempting to repair the disk. To do this, go to
'My Computer', right click on the faulty drive, select

•

Install security software and update it regularly.
Turn on automatic updates so all your software
receives the latest fixes.
Set strong passwords, particularly for important
online accounts and change them regularly —
consider making a diary entry to remind
yourself.
Stop and think before you click on links or
attachments in emails.
Stop and think before you share any personal
or financial information—about you, your
friends or family.
Know what your children are doing online.
Make sure they know how to stay safe and
encourage them to report anything suspicious.

On this website you can subscribe to the Stay Smart
Online Alert Service, a free service that provides
information on the latest computer network threats and
vulnerabilities in simple, non-technical, easy to
understand language. It also provides solutions to help
manage these risks.
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Tech Tips – Email Mistakes by Bill Maxwell
10 Common E-Mail Habits that Waste Time and
Cause Problems:
1. Vague or non existent subject line.
Make it easy for recipients to know what your message
is about. If you’re like most people, you have an inbasket that summarizes your incoming messages,
probably by date, sender, and subject. Don’t you love it
when you can get the information you need simply from
the subject line? The sender has made it easy for you
and has saved you time.
2. Changing the topic without changing the
subject.
E-mail users employ bait and switch all too often,
usually out of laziness. For example, you send a note to
a co-worker about subject 1. That co-worker later
needs to send a note to you on subject 2. However,
instead of creating a new note and labelling it “subject
2,” he or she simply replies to you, discusses subject 2,
but keeps the subject line as “subject 1.” Annoying, isn’t
it? When you send e-mail, make sure the subject line
matches the actual subject. If you’re going to send a
note via a reply, change the subject line to match the
actual subject.
3. Including multiple subjects in one email.
Covering multiple topics in one email involves less
sending and hence less email traffic and volume.
However, your recipient might overlook one or more of
those topics. It is better to keep to one topic per
message.
4. Sending before thinking.
Make sure you really mean to say what you’ve written.
People can interpret your words differently from what
you meant. A statement made in jest to someone via email may have a greater chance of being misinterpreted
than one made in person. Also, be careful about
reacting and replying too quickly to an e-mail that
upsets you.
5. Inadvertent replying to all.
Before hitting REPLY TO ALL, make sure you really need
to do so. Does everyone need to see your response.
Does your response benefit everyone else?
6. Omitting the context of a reply.
As long as it's not overdone, including the text of the
original message in your reply can help the original
sender understand your response. If all you send back
however, is a YES or That's Right, it may be difficult for
the sender to understand your answer.

7 Shooting the messenger.
Make sure you make the proper distinctions when you
reply to an email. When you reply, address your
comments to person A, the sender of the message and
not the person they were talking about.
8. Misaddressed recipients.
Be careful when addressing email, particularly if your
software has a "predictive fill-in" feature.
9. Displaying addresses of recipients who are
strangers to each other.
Were you ever the recipient of an e-mail that had a
gazillion other recipients as well? The message header,
which had all of those recipient addresses, probably
took up half your screen. Besides annoying you, the
sender might have compromised your privacy by
revealing your e-mail address to all the other recipients.
Don’t make the same mistake. If you're POSITIVE that
each of your recipients already knows (or could find out
anyway) the address of every other recipient (e.g.,
they’re all in your company), and if the number of
recipients is fairly small, go ahead and list them.
Otherwise, address the note to yourself and put the
recipient addresses in your blind carbon copy (bcc)
field. Your recipients will not see who received your
note, thus saving space and protecting the privacy of
each recipient.
10. Replying VS forwarding.
Didn’t you hate it when you were young and your
parents talked about you to their friends while you were
present? They’d refer to you in the third person, as if
you weren’t even there.
I thought about that situation last week after talking to
a prospective client with whom I had spoken a few
months earlier. I sent him an e-mail with links to my
TechRepublic articles and blogs. Later that day, I
received a reply from him. However, when I opened it,
here’s what I read:
John,
Despite his claim, I don't remember talking with Calvin
before. It may have happened but wasn't memorable.
When you have time, could you read his article and let
me know if it is worth doing anything else with it?
Thanks.
Of course, the prospective client meant to forward my
note to John (presumably a subordinate). Instead, he
hit Reply, sending his note right back to me, not to his
subordinate.
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ABC iView – from ABC website
Overview
iView is designed to work with computers that have a
high-speed broadband connection like ADSL2.
The iView widget is the perfect way to keep on top of
the featured and recently added programs to iView. It
also details the programs that are about to expire and
will send you straight to streaming the show when you
click on the links.
There are a range of participating ISPs that iView is
provided unmetered.

What is iView?
ABC iView is a free internet broadcasting service which
offers full-screen video, streamed on-demand and at a
high resolution. It's been created for the growing
number of people with high speed internet connections
who want good quality pictures and great content to
watch on their computer.
How does it work?
ABC iView streams video, so there's no need to wait for
downloads. Just hit the play button and you can watch
high-quality, full-screen video straight away. It's
designed to work with computers that have a high
speed broadband connection like ADSL2 (1.1Mbps and
above).
There are numerous genres available for you to browse
including Arts and Culture, Comedy, Documentary,
Drama and Lifestyle along with News. Or you can view
a list of all the programs available on the service via
ABC1, ABC2 and iView exclusive groupings. If you see a
show you like, you can save it in your playlist so you
can watch all your favourite shows one after another.
It's like programming your own TV channel. (Please
note the playlist functionality is temporarily suppressed
however we are hoping to bring it back as soon as
possible)

the menu, press the back button. You can also use the
escape key on your keyboard to return to a standard
browser window. You can then resize the window to
any size you like.
How often is ABC iView content updated?
Videos of the selected programs will be published after
they have appeared on TV. Usually they will appear the
next day.
Why do the programs expire?
The service is targeted at viewers who expect the audio
and video quality to be "the highest available", but want
to avoid substantial download charges; and all file sizes
are declared before users press play on a program. To
minimise the cost to the ABC of hosting these large
media files, programs will only be offered for a period
of time, up to 30 days. The expiry period is sometimes
determined by rights restrictions too.
Will ABC iView affect my internet service
provider download limits?
ABC iView is unmetered on some ISPs. This means you
can watch iView through these ISPs without eating into
your monthly allowable bandwidth. If you are unaware
of your download quota, please check with your
internet service provider.
For metered ISPs, viewing any of the streaming video
content on ABC iView will count towards your download
limit. As you press "play" the size and duration of each
video file will display to help you manage this. For
example, a half hour episode of At the Movies is 125
MB. However, if you only watch 10 minutes of it, you
will only consume 40 MB of data.
Does it work on all operating systems?
It works on Mac, PC and Linux.

When you select a video, you'll get an automatic
preview and more information about the show. The info
box also tells you when it was added, how many days
until the program expires, how big the file size, show
classification, duration plus links to the program's
website, download options as well as an 'email to a
friend' function.
By pressing play you go straight to full screen. You can
pause, fast forward or rewind programs. To return to
Page 10
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Bits & Pieces
Continued from page 9

Insert the plastic bag through the neck and
screw the top to seal.

Tech Tips - Email Mistakes by Bill Maxwell
Be careful that you don’t do the same thing. If you’re
writing about person B but sending the note to person
C, make sure you do forward (or send) your note to C
and that you don’t inadvertently reply to B.
By the way, after getting this note, I replied back to the
person, asking whether the note had been meant for
someone else and offering to figure out who “John” was
and to send him the note directly. The person replied
again, apologizing and admitting that he was poor at
multi-tasking.

The bag is made to be air-tight, such that water
will not leak, the secret lies with the top and
screw cap!
This is a great idea to share.
Good for us and the environment too.
Zip-top bags are great, but sometimes
something in bulk and you're stuck
unsealable bag. Home-centric blog
shows us an easy way to give these
airtight seal with an old water bottle.

USE OF BOTTLE TOPS TO SEAL A
BAG.....
WHO EVER THOUGHT OF THIS SHOULD GET A GREEN
MEDAL
WHAT A GREAT IDEA. NO MORE TWIST TIES OR
RUBBER BANDS. This method is WATER PROOF
AND AIR TIGHT. GREAT!

you buy
with an
Re-Nest
bags an

All you need to do is cut off the top of the bottle
and take off the cap. Push the bag through the
bottle neck, fold it over the edges, and twist the
cap back on. Now, your bag has an air and water
tight seal, and you didn't have to waste the bag.

The guy who first thought of the idea should be
given an award for originality!!!

Seal Plastic Bags with Old Bottle Caps
<http://lifehacker.com/5653113/seal-plastic-bags-withold-bottle-caps>

Cut up a disposable water bottle and keep the
neck and top, as in photo.
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Raffle
THE LAST SCCC RAFFLE WAS DRAWN 22 JUNE 2011 AT THE BUDERIM MEETING using the Random
Number Generator
The prize was a Tom Tom GPS (Global Positioning System) – Model VIA 180.
The TomTom Via makes navigation a breeze, putting you firmly in the driving seat.
Designed for convenience, it also lets you use your voice for many different tasks
and get accurate arrival times through IQ Routes on top of the very best maps.
The lucky winner with ticket number 152 was Max Young who bought the ticket at
a Buderim meeting.
Thank you to the members who supported this raffle and to the members manning the desks and selling tickets
in the raffle.

RAFFLE TO BE DRAWN SATURDAY 16 JULY 2011 AT CALOUNDRA
Following the popularity of the previous Club raffle when the prize was a Blackberry Pearl 9100
Smartphone another of these has been obtained for the raffle to be drawn at the Caloundra
Meeting on Saturday 16 July 2011. This is one of those telephones that will keep the winner up
to date with the latest. It will do everything you want and more. You can send e mail and text
messages, use it for video recording, as a media player, browser, for instant messaging, listening
to music for up to thirty hours and of course chat and much more. Read about all the features
when you buy your tickets.
For all that, tickets are one dollar each and available at all meetings until the day of the draw.
Remember buying of tickets is voluntary

RAFFLE TO BE DRAWN THURSDAY 18 AUGUST AT BUDERIM
Another exciting Raffle Prize. Win the BenQ S11 Full HD Digital Video Camera 1080p
with Built-in Pico Projector, and capture life's highlights in spectacular 1080p Full HD
video, then showcase them in a screening for friends and family—all with BenQ's
trendsetting DV S11. The built-in projector lets you share movies anytime, anywhere
right from a device that fits in your pocket. It's a new source of fun, and you can
have it to go.
Read the specifications when you are buying your tickets.
Tickets are one dollar each and available at all meetings from 21 July 2011 to day of draw.
Remember buying of tickets is voluntary.
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Corporate Members
Help with Computers

Peter Daley

Andrew Hadland Diploma ICT
Phone 5491 8645
•
•
•
•
•

Help with all aspects of Computer
Functions
Tuition – Emails – Scanning – Video
Editing
Burning CD's / DVD's – Backups
Protection Anti Virus – Spyware – Firewall
Internet – ADSL Setup

Computer Repairs and Upgrades for
Windows and Linux. Data Recovery,
Computer and Internet Training and
Setup. Home Entertainment and Hi Fi
systems setups and advice. Custom built
computers, all computer systems are
tested before pickup. Award Winning
Web Page Designer!
E-mail: ( Peter Daley)...

Computer - Repairs - New Systems

PH 0754913279
| Free Books | | Links | | E-mail |

Welfare Officer
Sunshine Coast Computer Club
Phone 54925443 Email
gregalach54@gmail.com
If you are ill or incapacitated or know of a
club member who needs some assistance or
would like to hear from the Club
contact our Welfare Officer Marie McGregor

Find Your Membership Number
Do you read your Bits'N'Bytes each month? Find your membership
number hidden somewhere in one of the pages and win five free tickets
in the current raffle.
The membership number will be chosen at random and will appear as a
four digit number within the text of the magazine and may be on any
page. If your membership number has 1, 2 or 3 digits, it will be shown
with leading 0s.
Do not forget to thoroughly scrutinise every magazine for your membership number hidden within the text of
articles each month.
The number is placed in the 8672 middle of a sentence like this!
Start looking now! The lucky membership number is hidden somewhere in this month's edition. Is it yours?
When you find your number contact the club by email at editor@sccc.org.au or phone 54921005 to claim your
prize. You are allowed 60 days from the publication date to claim your prize. Otherwise, the prize is forfeited!
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Classified Ads
Classified Advertisements in Bits'N'Bytes - Editorial Policy is that B'N'B Classified Advertisement 1. Are for the use of members only.
2. Items must not be of a business or commercial nature.
3. Items submitted should be limited to a few items - no huge garage sale lists please!
4. Items should preferably be relevant to computers, graphics, video, audio, electrical or electronic hobbies
etc. Adverts for other types of household goods will be accepted only if there is sufficient room for them.
5. Ads should preferably be forwarded direct to editor@sccc.org.au or phoned in to 54913279.
6. The Editor reserves the right to reject or edit any material .Editor reserves the right to reject or edit

FOR HIRE OR LOAN

Don't Forget
New Timess at Buderim Venue

The Sunshine Coast Computer Club owns data
projectors, laptops, external DVD burners, scanners,
digital cameras, etc.
This equipment is available for hire or loan to members
when it is not required by the club for meetings and
presentations.

Starting Thursday 7th July 2011
Meeting Times at Goodlife Centre Buderim

Contact your club if you need to borrow or hire
equipment.

Will Be

Email: sccc@sccc.org.au

1.00pm to 4.00pm

Telephone: 0754921005

MEMBERS CAN USE THIS SPACE TO ADVERTISE
THOSE UNUSED COMPUTER PIECES NO LONGER
BEING USED & ARE COLLECTING DUST ON THE
SHELF OR FILLING A SPACE IN THE CUPBOARD.
See notes above for advertising policy
Send your notices to
editor@sccc.org.au

Place Your Classified Ad on this page.
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Item (Prices include GST)

Number

Bits'N'Bytes Ezine Archives CD - June 1998 to December 2010.
Bits'N'Bytes Ezine Archives CD – trade in your old copy.

@ $10 each
@ $5 each

Multimedia CD - Clip Art, Animations, Midi and Wav files and
background colours to add to cards, emails etc. Multimedia CD
Upgrade (With old version CD returned)

@$10 each
@ $5 each

Postage (for one or more CDs)

Cost

$3.00

Post to : SCCC, Post Office Box 384, Caloundra
Enclosed
Cheque / Money Order / Cash

4551
Total

Surf Watch - Members Web Sites...Submit Yours

Member
Peter Daley

Very Useful Links
http://www.ozemail.com.au/~vital1/lstlinks.htm

Peter Daley

Fantasyland Creations http://www.ozemail.com.au/~vital1/

Peter Daley

Daley Positive Personal Development
http://www.ozemail.com.au/~vital1/freebks.htm

Jay Leboutillier

Website Design Centre http://www.websitedesigncentre.com.au/

Technologypals

Corporate member http://www.technologypals.com.au

Bill Maxwell

IT Knowledge Base for Seniors http://it.flexinet.com.au/

Your Committee
President

Peter Daley

5491 3279 (VOIP)09134402

Vice President

Heather Atkinson

5444 0886 (VOIP) 09110928

Secretary

Marie McGregor

5492 5443

Treasurer

Leo Kavanagh

5492 1786

Administration Co-ordinator

Jean Lear

5492 1151

Committee

Tom Bray

5479 3149

Committee

Morry Phillips

5491 1148

Committee

George Lupsa

5445 3850

Committee

Jim McGregor

5492 5443

Committee

Ian Smyth

5491 9139

Committee

Andrew Hadland

5491 8645

Committee

Don Wallace

0401 093 692

Committee

Peter Dodwell

5438 7675

Club Intranet
The Club Intranet is available at all meeting venues. It is packed with up to date free software, tutorials and back
issues of Bits'N'Bytes. Access it from any networked computer at the venue.
Type In your browser address bar:192.168.2.222 At both Buderim and Caloundra and Yandina when
available.
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SCCC Membership Application/Renewal Form
Applications can be posted to SCCC Inc., P O Box 384, Caloundra, 4551
or presented at a meeting
I wish to apply for membership
I wish to renew my membership

Name(s):

Address:
City:

Postcode:

Phone:
Email:
I will collect my membership card from Caloundra

Buderim

Yandina

Membership fees include the electronic version of the club
magazine.

Amount

Individual

$35

Family

$45

Corporate (Includes a monthly advertisement in the club magazine)

$60

Junior (Under 18 Years of Age)

$20

For the additional cost of $12 you may subscribe to a printed and posted
paper version of the club magazine.
Magazine subscription

$12
Total Enclosed $

Signature:
If after joining you don't receive your magazine within one month,
please contact the Club.
SCCC Office Use
Date Paid:

Amount: $

Receipt Number:

Membership Number:

Signed:

Nominated:
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